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File Menu

The File menu includes commands that enable you to open and save files, to batch convert
files to JPEG, and to display multiple images in a selected order.

For more information, select the File menu command name.
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Edit Menu

The Edit menu includes commands that enable you to transfer images to and from the
clipboard, to change the color components of an image, and to manipulate the image.

For more information, select the Edit menu command name.

Color Balance
Contrast Enhancement
Gamma Correction

Grayscale

Negative

Bit Slicing

Color Reduction
Increase Color Depth
Rotate

Flip Horizontal

Flip Vertical
Resize
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Crop Stretched/Zoomed Image
Filters




View Menu

The View menu includes commands that let you view an image with its full palette, in full
screen mode, or with different scales without changing the image data.

For more information, select the View menu command name.

Full Palette

Stretch Image to Fit Window
Keep Aspect Ratio if Stretched
Full Screen

Zoom In/Fixed Scale

Zoom In/Selected Scale

Zoom Out/Fixed Scale

Zoom Out/Selected Scale
Zoom In/Out Region

Exit Zoom Mode




Capture Menu

The Capture menu includes commands that let you capture the entire screen, a part of the
screen, a window, or a part of a window.

For more information, select the Capture menu command name.

Window
Client Area
Desktop

Area of Desktop
Hide Window



Filters Menu

After a color image is filtered by WinJPEG, the color depth of the image is maintained.
Consequently, if the color image is not 24-bit, the dithering that is used to maintain the color
depth may degrade the accuracy of the filtered pixels. If accuracy is important in your
application, you should convert the color image to 24-bit with the Increase Color Depth
menu command before you use any of the filters. 8-bit grayscale images do not need to be
converted to 24-bit.

For information about a filter, select a filter.

Sharpen
Smooth

Laplacian

Point Detection
Line Detection
Edge Detection
Median
Custom




Sharpen Filter (Filters Menu)

Increases the local contrast in the displayed image.



Smooth Filter (Filters Menu)

Blurs the edges and small detail in the displayed image.



Laplacian Filter (Filters Menu)

The Laplacian filter is a second order derivative that enhances the edges in an image.

Other edge detectors like the Sobel operators are preferred because the Laplacian is
sensitive to noise. The Laplacian is usually used to determine whether a pixel is on the light
or dark side of an edge.



Point Detection Filter (Filters Menu)

The point detection filter is used for detecting isolated pixels in the displayed image.



Line Detection Filter (Filters Menu)

The line detection filters are used for detecting horizontal, vertical, 45 degree, or -45 degree
lines that are one pixel wide.



Edge Detection Filter (Filters Menu)

The edge detection filters are gradient operators that are used to detect edges in an image.
The Roberts operators are based on a simple approximation of the gradient and generally
produce poorer results than the Prewitt and Sobel operators.



Median Filter (Filters Menu)

The median filter is a smoothing filter that is used to reduce noise in an image. The filter
replaces each pixel in the image with the median value, the 5th largest value in the pixel's
3x3 neighborhood.



Custom Filter (Filters Menu)

The custom filter lets you define your own 3x3 filter. For each pixel in the image, the new
pixel value is calculated in the following way. The 3x3 filter is centered "on top of" a pixel in
the image, and the filter weights are multiplied with the corresponding pixels "under" the
weights. The sum of those products is then divided by the Scale, and the Offset is added to
the result.



Options Menu

The Options menu includes commands that let you determine how other commands operate.
The settings for the options can be saved with the Save All Options command.

For more information, select the Options menu command name.

Maximum Color Depth
Auto-Preview
Suppress Warnings
Disable Undo

Window Options

JPEG Options

Memory Options
Slideshow Options




Open command (File Menu)

Select the name of a file to display. The file formats that are supported are BMP (Windows
or OS/2), GIF 87a/89a, IFF, JPEG File Interchange Format (JFIF), PCX, PPM, Targa, and TIFF. To
cancel an open while it is in progress, press the ESC key or use the File Cancel menu item.

The Info button is used to display a selected file's file attributes such as the file size and the
time it is created. Also, it is used to identify the file format and display information about
the image such as its resolution, color depth, and other data.

Pressing the Preview button will quickly display a grayscale thumbnail of a selected JPEG
image.



Save command (File Menu)

Save the displayed image with the same filename and the same file format as the opened
file. If the file format is not supported in the save feature, the save dialog will appear and it
will let you choose a supported format. To cancel a save while it is in progress, press the
ESC key or use the File Cancel menu item.



Save As command (File Menu)

Select the name of the output file and the output format, which is BMP (Windows or 0S/2),
GIF 87a, IFF, JPEG File Interchange Format (JFIF), PCX, PPM, uncompressed Targa, or TIFF.
The Sub-format button can be used to invoke a dialog that lets you set the options of the
BMP, IFF, JFIF, or TIFF format. To cancel a save while it is in progress, press the ESC key or
use the File Cancel menu item.



Save All Options command (File Menu)

This will save all the WinJPEG options to a file named "winjpeg.sav" in the same directory as
the WinJPEG executable. When Win)JPEG is initially loaded, the options will be loaded if
"winjpeg.sav" exists.



Delete command (File Menu)

This menu command lets you delete the file containing the currently displayed image.
WinJPEG will prompt you for confirmation before deleting the file. To delete an image during

a slideshow, press the Delete key.



Batch Conversion command (File Menu)

Batch conversion converts selected file(s) to a specified file format. If you are converting to
the BMP, IFF, JPEG FIF, or TIFF format, the options of that format can be set by pressing the
Sub-format button and changing the settings in the Options dialog box.

To choose a list of files to convert, you must select the desired files by clicking on them and
add them to the selected files-list by pressing the Add button. The Select All and
Unselect All buttons let you quickly select and unselect, respectively, all of the files in the
files-list box. To remove files from the selected files-list, select the files you want removed
and press the Remove button.

To cancel the conversion of a single file while it is in progress, press the ESC key or use the
File Cancel menu item. To abort the batch conversion completely, press CTRL+F4 or use
the Cancel Batch Conversion menu item.

The output files will have the same name as the input files except that they will have the
extension that is shown in the output file format list. Also, the output files will be placed in
the same directory path in which the input files were located.

If the compression type is not valid for the input image(e.g. converting a non-bilevel image
to TIFF with CCITT Group 3 compression), the output image will not be compressed.



Slideshow command (File Menu)

To select BMP, GIF, IFF, JPEG, PCX, PPM, Targa, or TIFF files to display in a slideshow, select
the desired files in the Files list box and press the Add button. The order in which you add
the selected files to your slideshow list determine the order in which they are displayed if
the Slide Order is set to Forward or Reverse in the Slideshow Options dialog box. Files can
be removed from the slideshow list by selecting files in the selected files-list and pressing
the Remove button.

To advance to the next file while WinJPEG is pausing, click on the window with the right
mouse button. To cancel an open while it is in progress, press the ESC key or use the File
Cancel menu item. To abort the entire slideshow, press CTRL+F4 or use the Cancel
Slideshow menu item.

See also Slideshow Options.



Print command (File Menu)

Print the image currently displayed. The Print dialog box lets you specify the Print
Quality and the number of Copies to print. The Print Setup dialog can be accessed before
printing.



Print Setup command (File Menu)

The Print Setup dialog box lets you select the Printer, page Orientation, and Paper
options. The Options dialog box allows printer driver-dependent options to be changed.



Print Options command (File Menu)

The displayed image can be printed in three ways: 1) best fit for the page, 2) fit for the full
page, or 3) scaled by a user-selected factor. Best Fit scales the image for maximum fit on
a printed page while maintaining the image's aspect ratio. Fit for Full Page scales the
image such that it fits the entire page. The Scale option scales the printed image's width
or height by an integer factor that is selected by the user.



1, 2, 3, 4 commands (File Menu)

The four most recently used file paths and their respective file types for viewing an image.
If you select one of these menu items, the open dialog will be displayed with a list of files
limited to the selected file type in the corresponding file path.



5, 6, 7, 8 commands (File Menu)

The four most recently opened images. Choosing one of these menu-items re-opens the
selected file.



Exit command (File Menu)

Exit from WinJPEG. While WInJPEG is compressing/decompressing an image, you can exit by
using the Close command in the system menu.



Undo command (Edit Menu)

Reverses the last change made to an image. If your system is low on memory, you can turn
off the undo feature with the Disable Undo option.



Redo command (Edit Menu)

Restores the last change that was "undo'ed."



Copy command (Edit Menu)

If a region of the image is selected (see Selecting a Region to Copy, Crop, or Zoom), copy
that region into the clipboard. Otherwise, copy the entire image into the clipboard.
WinJPEG posts the image in Windows bitmap and Device-Independent Bitmap(DIB) formats.



Paste command (Edit Menu)

Paste an image from the clipboard. The clipboard must contain either a Windows bitmap or
a Device-Independent Bitmap(DIB).



HSV Adjustment command (Edit Menu)

Use the scroll bars to adjust the amount of hue, saturation, and value/brightness in an
image. A value of 0 on the scroll bar means that there is no change in the corresponding
color component. When the value is increased or decreased, the color component is
increased or decreased, respectively.



Color Balance command (Edit Menu)

Use the scroll bars to adjust the amount of red, green, and blue in an image. A value of 0
on the scroll bar means that there is no change in the corresponding color component.
When the value is increased or decreased, the color component is increased or decreased,
respectively.



Contrast Enhancement command (Edit Menu)

Use the scroll bar to adjust the amount of contrast in an image. A value of 0 on the scroll
bar means that there is no change in the contrast. When the value is increased or
decreased, the contrast is increased or decreased, respectively.



Gamma Correction command (Edit Menu)

Use the scroll bar to adjust the amount of gamma. A value of 1.0 on the scroll bar means
that there is no change in the image. In general, increasing the gamma makes the image
lighter and decreasing it makes the image darker. A gamma of 2.2 is a commonly used
value.



Grayscale command (Edit Menu)

Convert a color image into a grayscale one.



Negative command (Edit Menu)

Obtain the negative of the image.



Bit Slicing command (Edit Menu)

Bit slicing is used to isolate a range of intensity values in a grayscale image or in a particular
color component of an image. Usually, pixels in the range of interest are set to 255(white),
and the remaining pixels are set to O(black). The new intensity values can be adjusted by
typing the values in the appropriate edit boxes. The upper and lower boundaries of the
range of interest can be set with the scroll bars.

For color images, you can bit slice a combination of the red, green, or blue color components
by checking the desired components in the Apply to group box.

The Preview button updates the image with the current bit slicing settings.



Color Reduction command (Edit Menu)

This dialog lets you reduce the number of colors in the displayed image to a specified
number of colors. There are buttons that let you choose a common color depth(1-bit, 4-
bit, 8-bit, 15-bit, and 16-bit) that corresponds to the number of colors in the right column.
You can also choose a custom number of colors in the new image.

If the specified number of colors is 256 colors or less, you can pick the palette of the color-
reduced image. If you choose the Optimal Palette, WinJPEG will determine the best set of
colors for the new palette. If you choose the Windows' System Palette, WinJPEG will use
the system colors, and it will include the optimal set of colors if there is space in the new
palette for the optimal colors. If you choose the Palette in the Clipboard, WinJPEG uses
the first X colors of the palette in the clipboard, where X is the new number of colors. If the
new color depth is 1-bit, you can select a Black and White Palette.



Increase Color Depth command (Edit Menu)

Increases the color depth of the displayed image to 24 bits per pixel. This command is
useful for preparing the image for the image processing functions like filtering. Processing
the image in 24 bits per pixel preserves the accuracy of the pixel data.



Rotate command (Edit Menu)

Rotate the image clockwise by 90 degrees.



Flip Horizontal command (Edit Menu)

Flip the image around the vertical axis.



Flip Vertical command (Edit Menu)

Flip the image around the horizontal axis.



Resize command (Edit Menu)

Change the spatial resolution of the displayed image. Common sizes such as 640x680,
800x600, 1024x768, and 1280x1024 can be easily selected. The Maximize Fit on
Desktop option will resize the image into the largest possible window that will fit on the
desktop while keeping the aspect ratio, the ratio between the original width and height.
Also, a custom size can be manually entered. If Keep Aspect Ratio is enabled, only one
dimension needs to be entered because the other one is automatically changed to maintain

the aspect ratio.



Crop command (Edit Menu)

If a region of the image is selected (see Selecting a Region to Copy, Crop or Zoom), keep
that region and discard the image outside of the selected region. If the image is stretched
or zoomed, the region corresponding to the pixels of the normal-sized image becomes the
new image.




Crop Stretched/Zoomed Image command (Edit Menu)

If a region of the stretched image is selected (see Selecting a Region to Copy, Crop or

Zoom), keep that region and discard the image outside of the selected region.



Window command (Capture Menu)

After selecting this menu item, the WinJPEG window hides itself and you must select a
window to capture by moving the mouse pointer over the desired window and clicking on
the window with the left mouse button. Some examples of a capturable window are a
window frame, a tool bar, an icon, etc.



Client Area command (Capture Menu)

After selecting this menu item, the WinJPEG window hides itself and you must select a client
area of a window to capture by moving the mouse pointer over the desired window and
clicking on the window with the left mouse button. The client area does not include the
window frame or menu bar.



Desktop command (Capture Menu)

Capture the entire desktop. See also the Hide Window option.



Desktop Area command (Capture Menu)

After selecting this menu item, you must select an area of the desktop to capture. To select
a region of the desktop, click on the desktop with the left mouse button. While holding
down that button, move your mouse until the rectangle surrounds the desired region, and
then release the mouse button. The dimensions of the selected region are displayed in the
center of the indicated region. See also the Hide Window option.



Hide Window command (Capture Menu)

When this option is checked, the WinJPEG window hides itself before capturing the desktop
with the Desktop or Area of Desktop command.



Full Palette command (View Menu)

Windows normally reserves 19 system colors for painting display elements like the
background color, window frame color, etc. If this option is checked and you are using a
256-color display mode, these colors are no longer reserved by the system and the image is
displayed with the image's full palette of colors. However, the system colors will look
incorrect until you turn this option off or exit WinJPEG.

If the option is off, Windows attempts to match system colors to colors in the image's palette
before reserving the colors it needs. In other words, if it can't find the system colors in the
image's palette, it will replace image palette entries with system colors. Up to 19 colors in
the image could be replaced by the system colors.

The Full Palette option is available in 256-color mode only.



Stretch Image to Fit Window command (View Menu)

When this option is checked, the scroll bars for the WinJPEG window are turned off and the
image is stretched to the dimensions of the client area of the WinJPEG window. This option
does not permanently change the resolution of the image. If you save the image, the
original image is saved, not the stretched one.



Keep Aspect Ratio if Stretched command (View Menu)

When this option is checked along with Stretch Image to Fit Window, the image is stretched
while maintaining the image's aspect ratio.




Full Screen command (View Menu)

View the currently displayed image with the full screen. If the image is larger than the
entire screen, the image will be resized with the best proportional fit before it is displayed.
If the image is smaller, it will be displayed in the center of the screen. To exit from full
screen mode, press any key or click on the screen with the left mouse button.



Zoom In/Fixed Scale command (View Menu)

View the currently displayed image enlarged by a factor specified by one of the fixed zoom
ratios.



Zoom In/Selected Scale command (View Menu)

View the currently displayed image enlarged by a user-selected zoom ratio or by a user-
selected percentage.



Zoom Out/Fixed Scale command (View Menu)

View the currently displayed image reduced by a factor specified by one of the fixed zoom
ratios.



Zoom Out/Selected Scale command (View Menu)

View the currently displayed image reduced by a user-selected zoom ratio or by a user-
selected percentage.



Zoom In/Out Region command (View Menu)

If a region of the image is selected (see "Selecting a Region to Copy, Crop, or Zoom"), scale
the image so that the region of interest is fully displayed in the WinJPEG window.



Exit Zoom Mode command (View Menu)

View the zoomed image at its normal size.



Maximum Color Depth command (Options Menu)

When you load or paste an image that has more colors than the Maximum Color Depth
setting, WinJPEG will reduce the number of colors to the Maximum Color Depth setting
before displaying the image. If you are viewing images, you should set this option to the
number of colors supported by your display driver. If you are converting images from one
file format to another, you should set it to 16.7 million colors.



Auto-Preview command (Options Menu)

If this option is checked, WinJPEG automatically displays a grayscale thumbnail of a JPEG
image when the user selects a JPEG file in the "File Open" dialog.



Suppress Warnings command (Options Menu)

If this option is checked, WinJPEG suppresses all warnings. Warnings occur when you load a
corrupted image, discard an image that has changed, or save an image that has lost data
because of quantization or dithering.



Disable Undo command (Options Menu)

If this option is checked, you will not be able to undo any changes to an image. Use this
option if your system is low on memory or if you don't need to undo changes to an image.



Windows Options command (Options Menu)

The Window Z-Order options determine the relative level of the WinJPEG window to other
windows on the desktop, immediately after an image is loaded. The level is not changed if
Keep Current Order is set. If the Below All Windows option is set, the WinJPEG window
will place itself under any window that overlaps it. If the Above All Windows choice is
selected, the WinJPEG window will placed itself on top of any window that overlaps it.

Whenever an image is loaded or resized, the Automatically Resize option will cause the
WinJPEG window to resize itself to fit the displayed image. If the image is larger than the
desktop, the window size is chosen such that it fits on the desktop, and the scroll bar(s) are
enabled to let you view the portion of the image that doesn't fit on the desktop.

If the Keep Current Size option is enabled, the window size does not change after an
image is loaded or resized. If the Show Scroll Bar(s) option is checked, the scroll bars(s)
are enabled if they are needed.

The last two options, Restore Window if Minimized and Move Window to Upper-Left
Corner of Desktop, are effective after an image is loaded and they are self-explanatory.



JPEG Options command (Options Menu)

The Quantization options are applied when Maximum Color Depth is set to 8-bits per
pixel or less. 2-pass quantization(specifically, Heckbert) calculates the optimal colormap
for the quantized image and produces better looking output than 1-pass quantization. 1-
pass quantization is slightly faster because a fixed colormap is used.

Dithering is the process of rendering an image on a display that supports less than the
number of colors in the image. Floyd-Steinberg Dithering, an error diffusion method,
should be turned on when your display is not truecolor(24-bit) and when Maximum Color
Depth is set to the number of colors supported by your display driver.

The Quality Factor, an integer between 0 and 100 inclusive, determines the tradeoff
between the output file size and the output image quality. If you choose a high quality
factor, the image quality will be high but the file size will be large. A lower quality setting
will yield a smaller file at a cost of lower fidelity. Since the JPEG algorithm is lossy, a quality
factor of 100 will not give you a losslessly compressed image.

The Smoothing Factor, also an integer between 0 and 100 inclusive, determines the
degree of smoothing to apply to an image before compressing that image with JPEG. The
higher you set the factor, the higher the degree of smoothing that is applied. A smoothing
factor of 0 means that no smoothing is performed. Smoothing removes noise introduced
when an image is dithered, and, in turn, smoothing produces a smaller JPEG file. It should
be used for only dithered images, like photographic GIF pictures. Generally, a factor
between 10 and 50 removes the dithering noise from an image.

Entropy Optimization produces a smaller JPEG file but it takes more time to encode the
image.



Memory Options command (Options Menu)

When WinJPEG needs more memory, it can use virtual memory, selected by the Available
Memory button, or it can use temporary files, selected by the Temporary File button. If
the former option is selected and WinJPEG runs out of virtual memory, temporary files will
automatically be used.

Temporary files are created in the directory chosen by the user and they are deleted when
WinJPEG is done with the memory or when the user aborts decompression/compression of an
image by closing the program.

In general, the Available Memory should be selected when your system has at least 8 MB
of RAM, and the Temporary File should be selected when you have little RAM or you are
multitasking memory-intensive programs.



Slideshow Options command (Options Menu)

The Slide Order determines the order in which the images in a slideshow list is displayed.
If Forward order is selected, the images are displayed in the order in which they are listed
in the slideshow dialog box. If Reverse order is chosen, the images are displayed in
reverse order from the last file to the first one in the slideshow list. If Random order is
selected, the files are displayed in a random order.

The Slide Advancement options determine how to advance to the next image in a
slideshow. In Manual mode, WinJPEG will wait until you click with the right mouse button
before advancing to the next picture. In Automatic mode, there will be a user-selected
time delay before the next picture is loaded. To advance to the next picture before the
delay has elapsed, click on the window with the right mouse button. The Delay can be set
to a value between 0 and 60 seconds.

The Buffer Image Formats options allow buffering of selected image formats during a
cyclic slideshow. If a type is selected, all images of that type are stored in memory after
they are loaded and decompressed, and they will not be loaded/decompressed the next time
they are displayed. This feature must be used in conjunction with the Cycle Slideshow
option. Buffering images can use a lot of memory; if you don't have much physical
memory, be certain that there is enough disk space on Window's swap drive to handle this
memory usage.

When a slideshow is running, the Cycle Slideshow option determines whether or not a list
of images are continuously displayed in a cycle. If this option is on, the slideshow returns
back to the first picture after the last one is displayed and continues to display all the
images in a selected list until you abort the slideshow.

The Full Screen option lets you display the images in the slideshow with the full screen as
described in the Full Screen section.



JPEG

Joint Photographic Experts Group (JPEG) refers to a still-picture compression standard that
specifies several modes of operation. The mode used by the Independent JPEG
Group's(lJPEG) software, which is incorporated into WinJPEG, is sequential buildup; in this
mode, each component of an image is encoded in a left-to-right and top-to-bottom scan.
Sequential mode is lossy, which means that when you compress an image, you will lose
information. That is, when you decode the compressed image, the decoded image will not
exactly match the original. One reason that sequential mode JPEG is lossy is that the

algorithm compresses an image by removing visually insignificant information, colors that
the human eye cannot detect.



Image File Formats
For more information, select an image file format.

Windows BMP and OS/2 BMP
Graphics Interchange Format (GIF)
Interchange Format File (IFF)

JPEG File Formats

PCX

Portable Pixmap (PPM)

Targa

Tagged Image File Format (TIFF)




JPEG File Formats

The JPEG committee has not specified a standard file format, and consequently, many
applications of the JPEG algorithm use their own proprietary format. WinJPEG uses the JPEG
File Interchange Format(JFIF) which transports only pixel information. JFIF is supported by
the IJPEG Group's software and other programs based on their code.

Handmade Software's GIF2JPG and Image Alchemy by default use a proprietary JPEG format
that is not compatible with the JFIF standard. This proprietary format is not supported by
WIinJPEG. When you use GIF2JPG, remember to use the "-j" option to produce a JPEG file
that is compatible with the JFIF standard and viewable with WinJPEG.

However, the GIF2JPG's "-j" option doesn't always produce a file in JFIF. If you have to use a

DOS converter, we recommend that you use the IJPEG Group's cjpeg program. Otherwise,
you should use WinJPEG's Batch Conversion feature, which performs the same task as cjpeg

except that only GIF, PPM, TIFF, and Targa images are supported.




Tagged Image File Format (TIFF)

WinJPEG supports a subset of the TIFF 6.0 specification. WinJPEG can view TIFF files stored
with 1, 4, 8, or 24 bits per pixel. WinJPEG can read TIFF images stored in strip format, in
which the image is divided into horizontal strips of pixels, and tile format, in which an
image is divided into rectangular grids of pixels. The compression modes CCITT (RLE,
RLEW, FAX3, FAX4), LZW, and Packbits can be read as well as uncompressed TIFF images.

WinJPEG can save uncompressed or compressed (Packbits, CCITT-FAX3, or LZW) TIFF files
TIFF files with 1, 4, 8, or 24 bits per pixel. TIFF files are saved in strip format.



Graphics Interchange Format (GIF)

WiInJPEG can view interlaced/non-interlaced GIF87a and GIF89a files and it can save non-
interlaced GIF87a files. If a GIF89a file contains more than one image, it will display the
first image in the file.



Targa

WinJPEG can view Targa files stored with 8, 15, 16, 24, or 32 bits per pixel and it can save
uncompressed Targa files with 8 or 24 bits per pixel.



PCX

WinJPEG can view PCX files stored with 1, 4, 8, or 24 bits per pixel. If a 1, 4, or 8 bits per
pixel PCX file does not have a valid palette, WinJPEG will use a default palette. It can save
PCX Version 3.0 files with 1, 4, 8, or 24 bits per pixel.



Windows BMP and 0S/2 BMP

WinJPEG can view Windows and OS/2 (1.x and 2.0) files stored with 1, 4, 8, or 24 bits per
pixel and can view BMP files that are run-length encoded(RLE). In addition, it can display
the first image in an 0S/2 (1.x and 2.0) bitmap array. It can save uncompressed Windows or
0S/2 (1.x and 2.0) BMP files in 1, 4, 8, or 24 bits per pixel and can save BMP files with RLE.

Note that some graphics viewers use the file extension ".RLE" for run-length encoded
Windows BMP files. WinJPEG uses the ".BMP" extension as a default for such files.



Portable Pixmap (PPM)

WinJPEG can view Portable Pixmap(PPM) and Portable Graymap(PGM) files. It can save a
subtype of the PPM format in which the pixel values are stored in binary. The color depth of

this subtype is always 24 bits per pixel.



Interchange Format File (IFF)

The IFF format is a standard for Commodore Amiga computers. WinJPEG can read/write
uncompressed and run-encoded FORM InterLeaved BitMap (ILBM) files stored with 1, 2, 4, 8,
or 24 bits per pixel. Hold And Modify(HAM) mode is also supported.



How to Register

If you use WinJPEG for more than 14 days, you are expected to register WinJPEG. When you
register, you will receive the latest 286 and 386 versions of WinJPEG, a user manual, and a
collection of JPEG images (we will put as many as we can fit on 1 1.44M 3 1/2" floppy or on 4
360k 5 1/4" floppies). Also, the registered version does not have the reminder-to-register
screen at the start.

The registration fee is $25. Massachusetts residents, add 5% sales tax to the registration
fee. US residents, add $4 for shipping and handling; non-US residents, add $8 for shipping
and handling. If you want WinJPEG e-mailed to your account instead of having it physically
mailed to you, there is no extra shipping charge. The above prices represent a cash
discount; if you are paying with a Visa or MasterCard, add 10% to this subtotal.

Registered users of WinJPEG can purchase the latest version for $5. Shipping and handling
fees described above apply to these updates as well. Updates are available when you see a
new shareware version.

For e-mail registrations, you need to use a program called "uudecode" to decode the
uuencoded file that we e-mail to you. For your information, a uuencoded file is a binary file
that is converted to text by a program called "uuencode." If your mail system rejects large
messages, we will split the uuencoded file into smaller parts before mailing the parts to you,
and you will need to edit the messages with a text editor before you can decode them.
Compuserve, America Online, and Prodigy, for example, do not permit large e-mail
messages. Also, the uuencoded file is rather large; it's approximately 1 MB for WinJPEG.
Compuserve users, for example, may find it less expensive to receive WinJPEG via U.S. Mail.

Registrations with the incorrect fee or with non-US currency will be returned. Foreign
registrations must send US currency or a check drawn from a US bank.

To register, complete the order form and send a check to:

PVS

ATTN: Norman Yee
58 Chandler St.
Boston, MA 02116
U.S.A.

Visit our Web page! URL: http://www.turnpike.net/metro/kyee/PVS.htmi



To print this form, select the File Print Topic menu item. If
you wish to type your order, edit the ORDER.FRM file that is
distributed with the shareware version and print it.

ORDER FORM

Name:

Company :

Address:

City: State: ZIP:

Country (if outside US):

Phone Number (optional): Circle: home or work
Shareware Version of Program evaluated (optional):

Where you found Shareware Version (optional):

Product Quantity Price Each Total
PMJPEG for 0S/2 2.x and Warp $20.00 U.Ss.
WinJPEG for Windows 3.x $25.00 U.S.
WinJPEG Update Fee (from any registered version of WinJPEG)
$5.00 U.sS.
Murals for Windows 3.x $15.00 U.S.

Merchandise Total:
5% Sales Tax (Massachusetts residents only):
Shipping and Handling (choose one):
E-mail (no additional charge)
U.S. residents ($4 U.S.)
Non-U.S. residents ($8 U.S.)
Subtotal:

Prices above reflect a 10% cash discount;
for Visa/MasterCard Orders, add 10% of Subtotal:
TOTAL:
(Non-credit card order payments must be in U.S. cash,
U.S. funds drawn on a U.S. bank, or a postal money order)

Please fill in the following for Credit Card Orders:

Signature:
Name on Card: Visa [ ] MasterCard [ ]
Credit Card Number: Expiration Date:

Choose Disk Size (check one if you did not select "E-mail" for
shipping) :
5 1/4" DS/DD (360K) disk
3 1/2" pDS/HD (1.44 MB) disk

E-mail Address (optional except E-mail Shipping):

Circle Type of Email Address: Internet Compuserve AOL Delphi
(Compuserve, AOL, and Delphi users, please be aware that a WinJPEG
E-mail registration can be sent to you in over 20 uuencoded parts



and

requires a program called uudecode to convert the uuencoded text

back
to a binary file.)

Mail to:
PVS
Attn: Norman Yee
(Compuserve)
58 Chandler St.
Boston, MA 02116
U.S.A.

E-mail Address:
nyee@netcom. com
INTERNET :nyee@netcom. com

(Internet)



Reporting Bugs

If you find a bug in WinJPEG, we would appreciate it if you would inform us of the bug
through our e-mail account:

nyee@netcom.com (Internet)
INTERNET:nyee@netcom.com (Compuserve)

When you send us a bug report, include a description of the procedure for reproducing the
bug and a description of your system configuration(hardware and software).



License Agreement (applicable to registered users)

You are licensed to single-copy use of WinJPEG; this means that you can install your
registered version of WinJPEG simultaneously on one computer at work, one computer at
home, and one portable computer, if only one copy is in use by the registered individual at a
time. You may make copies of the registered WinJPEG disk as necessary for normal backup
purposes; you agree not to make any copies of the printed WinJPEG manual or the registered
version of WinJPEG for others.



Disclaimer

The authors of this program accept no responsibility for damages that are caused by this
program and make NO WARRANTY or representation, either express or implied, with respect
to this software. This software is provided "AS IS," and you, its user, assume the entire risk

when you use it.
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Win)JPEG Features

WinJPEG v.2.7 is a shareware image viewer with image processing and conversion
capabilities for Microsoft Windows 3.x. It has the following features:

» Supports the following file formats:
« BMP (Windows 3.x, 0S/2 1.1, and 05/2 2.0)
« Graphics Interchange Format (GIF)
« Interchange Format File (IFF)
« JPEG File Interchange Format (JFIF)
« PCX
« Portable Pixmap (PPM)
» Targa
« Tagged Image File Format (TIFF)
« Display an image with its full palette or in full screen mode
« Zoom with fixed or user-selected scales
« Print an image with scaling or with best proportional fit on the page
« Image processing features:
« red/green/blue or hue/saturation/brightness adjustment
« color to grayscale conversion or image negative conversion
» contrast enhancement
« gamma correction
« image rotation, vertical or horizontal flip, image resizing, and image cropping
« filters including sharpen, smooth, Laplacian, point detection, line detection, edge
detection, median, or custom filters
« bit slicing
« color reduction
« Batch file conversion of a list of files to a specified format
« Slideshow features:
« display selected files in forward, reverse, or random order with a cycle option
« image buffering in a cyclic slideshow
« slideshows can be started from the command line
« Clipboard support
« Screen capture
» Support for Windows 3.1 features like drag-drop and common dialogs
« Support for file name extension association

There are three versions of WinJPEG: a 386+ version for 386's or better, a 386 version for
386's or better, and a 286 one for 286's or better. The shareware version is a fully
functional 386 version. The 386+ version is almost twice as fast as the shareware version
in decoding JPEG's without sacrificing image quality, and it can be obtained by registering
WinJPEG. See How to Register for more information.




Drag-drop Support

If you are using Windows 3.1, when you drag one or more files from File Manager to an open
WinJPEG and drop them there, WinJPEG will automatically enter the slideshow mode and
display those files in the order in which they are listed in File Manager. There is a delay,
which can be set in the Slideshow dialog box, between displayed pictures.



Selecting a Region to Copy, Crop, or Zoom

To select a region of the image, click on the image with the left mouse button. While
holding down that button, move your mouse until the rectangle surrounds the desired
region, and then release the mouse button. The dimensions of the selected region are
displayed in the center of the indicated region.



Converting File Formats with WinJPEG

Images can be converted from one file format to another in two ways: 1) you can use the
Batch Conversion feature to convert a list of files to a selected file format, or 2) you can load
an image with the File Open menu item and save it to the desired file format with the File_
Save As menu item.

If you choose the latter method, you should set the Maximum Color Depth option to 24-bit
before loading an image if you don't want the image degraded. If the color depth of the
image is greater than the Maximum Color Depth setting, the color depth of the image is
reduced to this setting after it is loaded. In this case, colors are lost, and noise is introduced
into the image by dithering. Setting Maximum Color Depth to 24-bits per pixel before
loading the image ensures that there is no color reduction. However, if you want to save
the image as it is displayed on your screen, you can leave the Maximum Color Depth set
to the number of colors supported by your display driver. The Maximum Color Depth
option does not affect images converted with the Batch Conversion feature.

When Win)JPEG performs color reduction on an image, WinJPEG will warn you when you try to
save that image.



Notes about 0S/2 2.0

When you run WinJPEG under 0S/2 2.0, WinJPEG cannot allocate more than 1 MB of
contiguous memory at a time. Because of this limitation in 0S/2 2.0, WinJPEG cannot
allocate enough contiguous memory if the image is too large. In addition, this limitation will
cause the JPEG code to use temporary files most of the time. 0S/2 2.1 allows Windows
applications to allocate more than 1 MB of contiguous memory and it fixes this problem.



Keyboard Accelerators

WinJPEG lets you use the following key combinations to perform the corresponding functions.

Key(s Function

Del Delete File

Alt + Backspace or Ctrl+Z Undo Changes

Alt + Shift + Backspace or Ctrl + R Redo Changes

Ctrl + Ins or Ctrl +C Copy Image to Clipboard

Shift + Ins or Ctrl +V Paste Image from Clipboard

Home Scroll Left by a Page

Up Arrow Scroll Up by One Pixel

Page Up Scroll Up by a Page

Left Arrow Scroll Left by One Pixel

Right Arrow Scroll Right by One Pixel

End Scroll Right by a Page

Down Arrow Scroll Down by One Pixel

Page Down Scroll Down by a Page

Esc Cancel File during Open, Save, Slideshow,
or Batch Conversion

Ctrl + F4 Cancel Slideshow or Batch Conversion

F10 Cancel File and Advance to Next Slide during Slideshow



Command Line Slideshow

A slideshow can be initiated from the DOS or Windows command line by adding a list of files
after the winjpeg.exe in the command line. For example, if you are starting WinJPEG and
Windows 3.x from the DOS command line, type following command at the DOS prompt to
display the three files, "mirri3.jpg, "mirri4.jpg," and "ksc.jpg":

win winjpeg.exe mirri3.jpg mirri4.jpg ksc.jpg
This example assumes that "winjpeg.exe" is in your search path and this command is
executed in the directory containing the images. If this is not the case, standard DOS paths
can be inserted in front of the filenames.
If you are already running Windows, you can start a command line slideshow from the
Program Manager's or File Manager's File Run menu command. For example, to display the
above files in a slideshow, type the following in the Command Line edit box:

winjpeg.exe mirri3.jpg mirri4.jpg ksc.jpg

The slideshow options last saved in WinJPEG will be used for the slideshow started from the
command line.






